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5 | Introduction
1 Introduction
In this chapter, you can find information about the intended use, the addressed 
target group, and information about safety and privacy related topics.

Please adhere to the ETAS Safety Advice (accessible via Help > Product 
Disclaimer) and to the safety information given in the user documentation.

ETAS GmbH cannot be made liable for damage which is caused by incorrect use 
and not adhering to the safety information.

1.1 Intended Use
The ASCET tools support model-based software development. In model-based 
development, you construct an executable specification – the model – of your 
system and establish its properties through simulation and testing in early stages 
of development. When a model behaves as required, it can be converted automat-
ically to production-quality code.

ASCET provides a multi-paradigm modeling framework, providing integrated sup-
port for a number of different modeling notations. These modeling notations 
abstract from low-level details, separating the concerns of what the system soft-
ware must do from how it is realized in code executing in the ECU. ASCET can also 
interface directly with C code as a "low-level" specification language.

ASCET provides a systematic way to augment the high-level specification 
(referred to as the physical model ) with the necessary information for target 
implementation (referred to as the implementation model ). The implementation 
model covers the low-level details required to make the model run on target hard-
ware.

The physical and implementation models are clearly separated in ASCET so that 
the design specification is not corrupted with implementation details that may 
change from project to project. Maintaining this separation also allows ASCET to 
support multiple implementation models for a single physical model, keeping the 
number of model variants low.

1.2 Target Group
This manual addresses qualified personnel working in the fields of automobile con-
trol unit development and calibration. Specialized knowledge in the areas of mea-
surement and control unit technology is required. 

ASCET users should be familiar with the Microsoft Windows® 10 operating system. 
Knowledge of a programming language, preferably ANSI-C, can be helpful when 
using ASCET.
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6 | Introduction
1.3 Classification of Safety Messages
Safety messages warn of dangers that can lead to personal injury or damage to 
property:

1.4 Safety Information
Observe the following safety information when using the NVRAM capabilities of 
the ASCET-RP or ASCET-SE targets, to avoid injury to yourself and others as well 
as damage to property:

DANGER
DANGER indicates a hazardous situation that, if not avoided, will result in death 
or serious injury.

WARNING
WARNING indicates a hazardous situation that, if not avoided, could result in 
death or serious injury.

CAUTION
CAUTION indicates a hazardous situation that, if not avoided, could result in 
minor or moderate injury.

NOTICE
NOTICE indicates a situation that, if not avoided, could result in damage to prop-
erty.

WARNING
Harm or property damage due to unpredictable behavior of vehicle or test 
bench 

Wrongly initialized NVRAM variables (NV variables) can lead to unpredictable 
behavior of a vehicle or a test bench. This behavior can cause harm or property 
damage.

ASCET projects that use the NVRAM possibilities of ASCET-RP targets expect a 
user-defined initialization that checks whether all NV variables are valid for the 
current project, both individually and in combination with other NV variables. If 
this is not the case, all NV variables have to be initialized with their (reasonable) 
default values.

Due to the NVRAM saving concept, this is absolutely necessary when projects 
are used in environments where any harm to people and equipment can happen 
when unsuitable initialization values are used (e.g. in-vehicle-use or at test 
benches).
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7 | Introduction
Adhere to the ETAS Safety Advice and the safety information given in the online 
help and user guides. You can open the ETAS Safety Advice from the main ASCET 
window with Help > Product Disclaimer. A PDF version is available on the installa-
tion medium: Documentation\ETAS Safety Advice.pdf 

In addition, take all information on environmental conditions into consideration 
before setup and operation (see the documentation of your computer, hardware, 
etc.).

Further safety advice for this ETAS product is available in the ASCET V6.4 safety 
manual, available at ETAS upon request. 

1.5 Data Protection
If the product contains functions that process personal data, legal requirements 
of data protection and data privacy laws shall be complied with by the customer. 
As the data controller, the customer usually designs subsequent processing. 
Therefore, he must check if the protective measures are sufficient.

1.6 Data and Information Security
To securely handle data in the context of this product, see the next sections 
about data and storage locations as well as technical and organizational mea-
sures.

1.6.1 Data and Storage Locations
The following sections give information about data and their respective storage 
locations for various use cases.

License Management
When using the ETAS License Manager in combination with user-based licenses 
that are managed on the FNP license server within the customer's network, the fol-
lowing data are stored for license management purposes:

Data

- Communication data: IP address

- User data: Windows user ID

Storage location

- FNP license server log files on the customer network

When using the ETAS License Manager in combination with host-based licenses 
that are provided as FNE machine-based licenses, the following data are stored for 
license management purposes:

Data

- Activation data: Activation ID

Used only for license activation, but not continuously during license usage
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Storage location

- FNE trusted storage

C:\ProgramData\ETAS\FlexNet\fne\license\ts

Problem Report
When an error occurs, ASCET offers to send an error report to ETAS for trouble-
shooting. ETAS uses the personal information to have a contact person in case of 
system errors.

The problem report may contain the following personal data or data category:

Data

- Communication data: IP address

- User data: Windows user ID, user name

Storage location:

- EtasLogFiles<index number>.zip in the ETAS-specific log files direc-
tory,

Additionally to the problem information that is entered by the users themselves, 
ASCET collects the available product-related log files in a zip archive to support 
the bug fixing process at ETAS. The zip file is named according to the pattern 
EtasLogFiles<index number>.zip.  See also chapter 5 "Support Function for 
Feedback to ETAS in Case of Errors"  in the ASCET Getting Started manual.

All ETAS-related log files in the ETAS-specific log files directory and the zip 
archives created by the Problem Report feature can be removed after closing all 
ETAS applications if they are no longer needed.

1.6.2 Technical and Organizational Measures
We recommend that your IT department takes appropriate technical and organi-
zational measures, such as classic theft protection and access protection to 
hardware and software.

Locations for Generated Files
Names and paths of files generated by ASCET  may contain personal data, if they 
refer to the current user's personal directory or subdirectories (e.g., 
C:\Users\<UserId>\Documents\...). 

If you do not want personal information to be included in the generated files, make 
sure of the following: 

- The workspace of the product points to a directory without personal refer-
ence. 

- All settings in the product (accessed via the menu function Tools > Options 
in the product) refer to directories and file names without personal refer-
ence. 

- All project settings in the projects (accessed via the menu function File > 
Properties in the ASCET project editor) refer to directories and file names 
without personal reference. 
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- Windows environment variables (such as the temporary directory) refer to 
directories without personal reference because these environment vari-
ables are used by the product. 

In this case, please also make sure that the users of this product have read and 
write access to the newly set directories. 
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2 About ASCET
The ASCET tools support model-based software development. In model-based 
development, you construct an executable specification – the model – of your 
system and establish its properties through simulation and testing in early stages 
of development. When the model behaves as required, it can be converted auto-
matically to production-quality code.

This manual lists the icons and symbols that appear in classes and modules spec-
ified as block diagrams.

2.1 Finding Out More
The ASCET Icon Reference Guide contains the following chapters:

- "Introduction" 

This chapter contains information on intended use, target group, safety, 
data protection, and data/information security.

- "About ASCET"  (this chapter)

This chapter contains general information. 

- "Operators in Block Diagrams" 

This chapter lists block diagram operators and their icons.

- "Control Flow Elements in Block Diagrams" 

This chapter lists control flow elements and their icons.

- "Elements in Block Diagrams" 

This chapter lists block diagram elements and their icons.

- "Miscellaneous Icons" 

This chapter lists the remaining icons and their meaning.

- "Contact Information" 

Contact information of the ETAS subsidiaries.

The following further documentation is available when you installed the respective 
ASCET product:

- ASCET base system

• ASCET Getting Started (this manual; ASCET V6.4 Getting 
Started.pdf)

• ASCET Installation Guide (ASCET V6.4 Installation.pdf)

• ASCET online help; accessible via the Help menu and <F1> in the various 
ASCET windows

• ASCET AUTOSAR User Guide (ASCET V6.4 AUTOSAR User 
Guide.pdf)
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• AUTOSAR to ASCET Importer User Guide (ASCET V6.4 AUTOSAR To 
ASCET Converter User Guide.pdf)

- ASCET-RP
• user guide (ASCET-RP V6.4 User Guide.pdf)
• separate online help; accessible via the Help menu and <F1> in the Hard-

ware Configurator 
- ASCET-SE

• ASCET-SE user guide (ASCET-SE V6.4 User Guide.pdf)
• EHOOKS Add-On user guide (ASCET-SE V6.4 EHOOKS Add On User 

Guide.pdf)
- ASCET-SCM

• online help (integrated in the main ASCET online help)
- ASCET-DIFF

• ASCET-DIFF installation guide
• separate online help; accessible via the Help menu and <F1> in the 

ASCET-DIFF windows

NOTE
The cooperation of ASCET and AUTOSAR requires the installation of 
the ASCET-SE target ANSI-C. 
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3 Operators in Block Diagrams
This chapter lists the operators available in ASCET block diagrams.

• arithmetic operators (section 3.1 on page 12)

• comparison operators (section 3.2 on page 13)

• logical operators (section 3.3 on page 14)

• multiplex operator (section 3.4 on page 14)

• case operator (section 3.5 on page 15)

• miscellaneous operators (section 3.6 on page 15)

3.1 Arithmetic Operators
The meaning of the operators is the same as in ESDL. The following operators are 
available: 

- Addition, Subtraction, Multiplication, Division, Modulo 

The addition and multiplication operators can have 2 to 20 arguments. The sub-
traction, division and modulo operators have only two arguments. 

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no arithmetic operators are shown in the "Navigation" tab.

block 
diagram

Addition Returns the sum of 
the inputs.

Subtraction Returns the difference 
between the upper 
and the lower input.

Multiplica-
tion

Returns the product of 
the inputs.

Division Returns the quotient 
of the upper and the 
lower input.

Modulo Returns the remainder 
of the division upper / 
lower input.
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3.2 Comparison Operators
The comparison operators are identical to their counterparts in ESDL. The follow-
ing comparison operators are available:

- Greater

- Smaller

- Smaller or Equal

- Greater or Equal

- Equal

- Not Equal

Each operator has 2 arguments. The Equal and Not Equal operators can be applied 
to arithmetic and non-arithmetic elements.

name  icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no comparison operators are shown in the "Navigation" tab.

block 
diagram

Greater Returns true if the upper 
input is greater than the 
lower input. 
Returns false otherwise.

Smaller Returns true if the upper 
input is smaller than the 
lower input.
Returns false otherwise.

Smaller 
or Equal

Returns true if the upper 
input is smaller than or 
equal to the lower input.
Returns false otherwise.

Greater 
or Equal

Returns true if the upper 
input is greater than or 
equal to the lower input.
Returns false otherwise.

Equal Returns true if the upper 
input is equal to the lower 
input.
Returns false otherwise.

Not 
Equal

Returns true if the upper 
input is not equal to the 
lower input.
Returns false otherwise.

Verify Returns true if original and 
complement of a redundant 
element are consistent.
Returns false otherwise.
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3.3 Logical Operators
The logical operators are identical to their counterparts in ESDL. The following log-
ical operators are available:

- And

- Or

- Not 

The And and Or operators can have 2 to 20 arguments, the Not operator has one 
argument.

3.4 Multiplex Operator
The conditional operator ( ? : ) is named Multiplex  operator (for short: Mux) in 
the graphical representation. 

The multiplex operator can be used with 2 to 20 arguments, however, the identical 
functionality of a multi-argument Mux operator can be built as a cascade of several 
2-argument Mux operators.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no logical operators are shown in the "Navigation" tab.

block 
diagram

And Returns true if all inputs are 
true.
Returns false if at least 
one input is false.

Or Returns true if at least one 
input is true.
Returns false if all inputs 
are false.

Not Returns true (false) if the 
input is false (true).

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Mux operators are shown in the "Navigation" tab.

block 
diagram

Mux The input on the top is the 
condition, the inputs on the 
left are the values.
The Mux operator returns 
the upper (lower) left input 
if the condition is false 
(true).
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3.5 Case Operator
The Case operator is a special case of the conditional operator. It does not take a 
logical value, but a switch value of discrete type. The Case operator has n argu-
ments (n = 2..20), n-1 of which are numbered consecutively. The last argument 
is the default case. 

Depending on the switch value, one of the arguments is selected. If the switch 
value is 1, the first argument is returned, if it is 2 the second is returned, and so on. 
If the switch value is < 1, or n, or > n, the last argument is returned. 

3.6 Miscellaneous Operators

Max and Min Operators: The Max and Min operators can have 2 to 20 argu-
ments; they can be applied only to arithmetic elements.

Between Operator: The Between operator checks if the argument value (upper 
input) lies between the limiters min (middle input) and max (lower input). If this is 
the case, the logical return value is true, otherwise it is set to false.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Case operators are shown in the "Navigation" tab.

block 
diagram

Case The input on the top is the 
switch value, the inputs on 
the left are the arguments.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Min/Max operators are shown in the "Navigation" tab.

block 
diagram

Max Returns the largest input 
value.

Min Returns the smallest input 
value.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Between operators are shown in the "Navigation" tab.

block 
diagram

Between Returns true (false) if 
the argument lies (does 
not lie) between min and 
max.
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Absolute Operator: Argument and return value of the Absolute operator have 
to be both either cont or discrete.

Negation Operator: Argument and return value of the Negation operator can be 
cont or discrete; if the argument is cont, the type of the return value should be the 
same.

Conversion Operator: The Conversion operator allows to convert scalar ele-
ments of numerical or enumeration type to limitInt or wrapInt types. The function 
of the convert operator is determined either via the button used to create the 
operator or via the Conversion Type submenu in the operator's context menu.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Absolute operators are shown in the "Navigation" tab.

block 
diagram

Absolute Returns the absolute 
value of the argument.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Negation operators are shown in the "Navigation" tab.

block 
diagram

Negation Returns the negative 
value of the argument.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Conversion operators are shown in the "Navigation" tab.

block 
diagram

Conversion 
Limit

Converts the argument 
to a limitInt type.

Conversion 
Wrap-
Around

 Converts the argument 
to a wrapInt type.
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Size Operators: The Size X and Size Y operators allow to access the X and Y (if 
applicable) size of arrays, matrices, characteristic curves/maps and distributions. 

Assert Operator: The Assert operator allows to specify lower and upper bound 
of an interval. This interval is then used by the code generator as the result interval 
of the Assert operator; the calculated interval of the operand is overwritten.

Communication Status Operator: The Communication Status operator is 
used to perform a request for the communication status of implicit communication 
in an AUTOSAR environment. You can use the status to determine if an implicit 
read access was successful. 

In a non-AUTOSAR environment, the status operator is always generated to OK. 
Code that becomes obsolete in that case is removed during code optimization. 
The same happens in an AUTOSAR environment if the RTE does not support the 
configured error code.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Size operators are shown in the "Navigation" tab.

block 
diagram

Size X Returns the X size of an 
array, matrix, characteris-
tic line/map or distribu-
tion.

Size Y Returns the Y size of a 
matrix or characteristic 
map.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Assert operators are shown in the "Navigation" tab.

block 
diagram

Assert Allows to specify lower 
and upper bound of an 
interval.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Communication Status operators are shown in the "Navigation" tab.

block 
diagram

Communi-
cation 
status

Returns the communica-
tion status for implicit 
communication in an 
AUTOSAR environment.
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4 Control Flow Elements in Block Diagrams
This chapter lists the control flow elements available in ASCET block diagrams. 

The following control flow statements are available in block diagrams:

- If...Then (section 4.1 on page 18)

- If...Then...Else (section 4.2 on page 19)

- Switch (section 4.3 on page 19)

- While (section 4.4 on page 20)

- Break Statement (section 4.5 on page 20)

All control flow statements except Break evaluate a logical expression and, 
depending on the result, activate a control flow branch which may contain several 
statements. The statements represented by sequence calls are connected to the 
control flow by connectors.

The Break statement can be used to exit immediately from each of the other con-
trol flow elements and return to another enclosing statement or to the remainder 
of the model. 

4.1 If...Then
The If...Then statement evaluates a logical expression. The control flow output is 
connected to one or more sequence calls which are triggered whenever the con-
trol flow branch is activated. Whenever the input expression evaluates to true, 
the connected sequence calls are executed.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no If...Then blocks are shown below the "Graphic Blocks" node in the
"Navigation" tab.

block diagram

If...Then  / Activates a control flow 
branch (connected to 
the output) if the input is 
true. 
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4.2 If...Then...Else
If...Then...Else is similar to If...Then, but has two control flow branches. Depending 
on the value of the logical expression, one of the branches is executed.

4.3 Switch
The Switch construct is similar to the Case operator (cf. section 3.5 on page 15). A 
Switch evaluates a signed discrete or unsigned discrete value and, depending on 
that value, activates different control flow branches. These branches are sepa-
rated from each other, so that a "fall through" like in the switch construct in C is not 
possible.

A switch can have 2 to 20 branches.

For each alternative, the value for the branch can be defined by the user. The last 
branch at the bottom is the default branch.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no If...Then...Else blocks are shown below the "Graphic Blocks" node in
the "Navigation" tab.

block diagram

If...Then...
Else

 /

 (if) /

 (else)

Activates the control 
flow branch on the right 
(connected to the out-
put) if the input is true. 
Activates the control 
flow branch at the bot-
tom if the input is false.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Switch blocks are shown below the "Graphic Blocks" node in the "Nav-
igation" tab.

block diagram

Switch  /

 (case) /

 (default)

Activates the control 
flow branch whose value 
is the same as the input 
value. 
Activates the default 
branch (at the bottom) if 
no branch value equals 
the input.
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4.4 While
The While loop is the only loop construct available in block diagrams . Care has to 
be taken to avoid infinite loops or loops unsuitable for real-time applications. 

4.5 Break
The break operator in the block diagram editor behaves similar to a C language 
return statement.  

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no While blocks are shown below the "Graphic Blocks" node in the "Nav-
igation" tab.

block diagram

While  Activates the control flow 
branch if the input value is 
true.
The operation is executed 
as long as the input value 
remains true; the input 
value should be manipu-
lated in the while loop.

NOTE
The break operator in the block diagram editor behaves differently from the 
break statement in ESDL.

name icon in remarks

palette/
toolbar

"Navigation" 
taba)

a) By default, no Break blocks are shown below the "Graphic Blocks" node in the "Nav-
igation" tab.

block diagram

Break In method: Causes an 
immediate return from the 
method. The user is 
responsible for the correct 
setting of any return values 
before break is executed.
In process: Causes a 
deferred exit (i.e. all send 
messages are sent before 
the exit occurs). 
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5 Elements in Block Diagrams
This chapter lists the elements available in ASCET block diagrams.

- section 5.1 "Scalar Elements" on page 21

- section 5.2 "Composite Elements" on page 24

- section 5.3 "Complex Elements (Included Components)" on page 29

- section 5.4 "Real-Time Elements" on page 29

- section 5.5 "Signature Elements" on page 32

- section 5.6 "Miscellaneous Elements" on page 35

5.1 Scalar Elements
Several scalar elements are available in ASCET block diagrams:

- variables (section 5.1.1 on page 21)

- parameters (section 5.1.2 on page 22)

- literals (section 5.1.3 on page 23)

- constants and system constants (section 5.1.4 on page 24)

5.1.1 Variables
The following types of scalar variables are available in ASCET block diagrams:

- Logic

- Limited integer

- Wrap-around integer

- Signed discrete

- Unsigned discrete

- Continuous

- Enumeration

The "Elements" palette provides a button for each variable, the "Elements" toolbar 
provides a single button with a sub-menu for the type of the numeric variable. The 
content of the submenu depends on the Use signed/unsigned discrete types 
option in the "Appearance\Editors" node of the ASCET options window.

In the block diagram, the type of a variable is not visible, only kind (variable, virtual 
variable) and scope (exported/imported/local) and some properties (virtual/non-
virtual, volatile/nonvolatile); see chapter 6 on page 38 for details.
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The type of a variable is shown in the "Tree Pane".

5.1.2 Parameters
The following types of scalar parameters are available in ASCET block diagrams:

- Logic, 

- Limited integer, 

- Wrap-around integer, 

- Signed discrete, 

- Unsigned discrete, 

- Continuous, 

- Enumeration

The "Elements" palette provides a button for each parameter, the "Elements" tool-
bar provides a single button with a sub-menu for the type of the numeric parame-
ter.

In the block diagram, the type of a parameter is not visible, only kind and scope 
(exported/imported/local) and some properties (e.g., normal/dependent); see 
chapter 6 on page 38 for details.

name palette 
icon

block diagram 
icona)

a) The patterns of the red squares indicate the scope (cf. section 6.1) and some prop-
erties (cf. section 6.2) of the variables.

"Tree Pane" icon

Logic Variable

Limited Integer Variable
(Signed Discrete 
Variable)

 ( )

Wrap-Around Integer 
Variable
(Unsigned Discrete 
Variable)

 ( )

Continuous Variable

Enumeration Variable
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The type of a parameter is shown in the "Tree Pane".

5.1.3 Literals
Literals are strings that represent a fixed value of a basic scalar type which can be 
used in any expression. The value of a literal is either a number (discrete or contin-
uous), a character string, or one of the values true or false (logical). 

The following literals are predefined in ASCET block diagrams:

- Enumeration literal

- Logic literal true
- Logic literal false
- Continuous literal 0.0
- Continuous literal 1.0

name palette 
icon

block diagram 
icona)

a) The patterns of the blue circles indicate the scope (cf. section 6.1) and some prop-
erties (cf. section 6.2) of the parameter.

"Tree Pane" icon

Logic Parameter

Limited Integer Parame-
ter
(Signed Discrete 
Parameter)

 ( )

Wrap-Around Integer 
Parameter
(Unsigned Discrete 
Parameter)

 ( )

Continuous Parameter

Enumeration Parameter

name palette / toolbar 
icon

block diagram 
icon

"Tree Pane" icona)

a) Literals are shown only in the "Navigation" tab. They do not appear in the "Outline"
tab.

Enumeration Literal

Logic Literal true

Logic Literal false

Continuous Literal 0.0

Continuous Literal 1.0
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5.1.4 Constants and System Constants
Constants and system constants cannot be created via palette or toolbar but-
tons. They are created with the parameter or variable buttons (cf. section 5.1.1 and 
section 5.1.2) and the appropriate selection (i.e. Constant or System Constant) 
in the "Kind" combo box of the properties editor.

Constants and system constants can be of scope exported, imported or local; 
they can be of the types logic, limited/wrap-around integer, signed/unsigned dis-
crete, continuous, enumeration (see also chapter 6 on page 38).

The representation of constants and system constants in the "Tree Pane" is simi-
lar to that of parameters (section 5.1.2), except for the overlay icon (= or #). User-
defined system constants can have user-defined overlay icons; see the online 
help for details.

5.2 Composite Elements
Several composite, i.e. non-scalar elements are available in ASCET block diagrams:

- arrays (section 5.2.1 on page 25)

- matrices (section 5.2.2 on page 25)

- characteristic lines and maps (section 5.2.3 on page 26)

Composite elements can be variables or parameters of any scope (cf. section 6.1). 
Arrays and matrices can also be used as messages; these are described in 
section 5.4.1 on page 29.

name palette / 
toolbar 
icon

block diagram 
icona)

a) The patterns of the blue circles indicate the scope (cf. section 6.1) and some prop-
erties (cf. section 6.2) of the constants and system constants.

"Tree Pane" 
icon

Remarks

Constant n/a Constants are created 
as a define statement 
in the generated 
C code. However, they 
are not necessarily 
explicitly visible in the 
generated code.

System 
Constant

n/a System constants are 
used like constants, 
and also created as 
define statements. 
System constants can 
be implemented. They 
are always explicitly 
visible in the gener-
ated code.
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5.2.1 Arrays
An array is a one-dimensional, indexed set of variables or parameters which have 
the same scalar type (logic, limited/wrap-around integer, signed/unsigned dis-
crete, continuous). This type is not visible in the diagram. In the "Tree Pane", no 
special icon indicates the array type, it is visible only textually in the "Outline" tab.

The position of a scalar value within an array is indicated by its associated index 
value which must be a non-negative integer. 

For the icon differences induced by scope, see section 6.1 on page 38.

5.2.2 Matrices
A matrix is a two-dimensional, indexed set of variables or parameters which have 
the same scalar type (logic, limited/wrap-around integer, signed/unsigned dis-
crete, continuous). This type is not visible in the diagram. In the "Tree Pane", no 
special icon indicates the matrix type, it is visible only textually in the "Outline" tab.

The position of a scalar value within a matrix is indicated by its associated X and Y 
index values, which must be non-negative integers. 

For the icon differences induced by scope, see section 6.1 on page 38.

name palette / 
toolbar icon

block diagram icon "Tree Pane" icon

Array 
(variable)

Array 
(parame-
ter)

name palette / 
toolbar icon

block diagram icon "Tree Pane" icon

Matrix 
(variable)

Matrix 
(parame-
ter)
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5.2.3 Characteristic Lines and Maps
To support nonlinear control engineering, characteristic lines and maps are avail-
able in ASCET block diagrams. They are used to describe a value in dependence of 
one or two other values. 

Characteristic lines and maps are available in the varieties normal, fixed, and 
group.

A fixed characteristic line/map has an equidistant distribution, i.e. the sample 
points have a constant distance from each other.

A group characteristic line/map does not contain a sample point distribution, but 
references an external distribution (cf. Page 27) of sample points.

Characteristic Lines
A characteristic line is represented as a one-dimensional table of sample points, 
each of which is associated with a sample value. The sample points represent the 
X axis of a function graph, the sample values represent the curve being described.

The "Elements" palette provides a combo box and a button for 
characteristic lines, the "Elements" toolbar provides a single but-
ton with a submenu for the variety.

In the block diagram, the types of sample points and values of a 
characteristic line are not visible, only kind, scope (exported/
imported/local) and some properties; see chapter 6 "Miscella-
neous Icons" for details. In the "Tree Pane", no special icons indicate the types, 
they are visible only textually in the "Outline" tab. 

Green (red) arrows indicate that the sample point distribution is strictly monotonic 
increasing (decreasing). No arrow is shown if strict monotony is not given.
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For the icon differences induced by scope, see section 6.1 on page 38.

Characteristic Maps
A characteristic map is represented as a two-dimensional table of sample points; 
each pair of sample points is associated with a sample value. 

The "Elements" palette provides a combo box and a button for 
characteristic maps, the "Elements" toolbar provides a single but-
ton with a submenu.

In the block diagram, the types of sample points and values of a 
characteristic map is not visible, only kind, scope (exported/
imported/local) and some properties; see chapter 6 on page 38 
for details. In the "Tree Pane", no special icons indicate the types, they are visible 
only textually in the "Outline" tab. 

Green (red) arrows indicate that the X sample point distribution is strictly mono-
tonic increasing (decreasing). No arrow is shown if strict monotony is not given. 

The monotony behavior of the Y sample point distribution is not shown in the block 
diagram.

name palette icon block diagram 
icon

"Tree Pane" icon

OneD Table 
(normal); strictly 
monotonic 
increasing

+ 

OneD Table 
(normal); strictly 
monotonic 
decreasing
OneD Table 
(normal); no 
strict monotony 

OneD Table 
(fixed)

+ 

OneD Table 
(group)

+ 

Distribution 
(required for 
group char. line)
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For the icon differences induced by scope, see section 6.1 on page 38.

name palette icon block diagram 
icon

"Tree Pane" icon

TwoD Table 
(normal); X axis 
strictly mono-
tonic increasing

+ 

TwoD Table 
(normal); X axis 
strictly mono-
tonic decreasing
TwoD Table 
(normal); no 
strict monotony 
for X axis
TwoD Table 
(fixed)

+ 

TwoD Table 
(group)

+ 

Distribution (2 
required for 
group char. map)
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5.3 Complex Elements (Included Components)
In a block diagram, an included component, or complex element, is represented by 
the component’s layout.

In the "Tree Pane", an included component is represented by its component type 
icon.

5.4 Real-Time Elements

5.4.1 Messages
Messages of scalar, composite (array, matrix) or complex (record) type form the 
input and output variables of processes and are used for inter-process communi-
cation. Three types of messages are available in ASCET block diagrams: 

- Receive messages

- Send messages

- Send & Receive messages

Scalar messages can be of the same type as variables and parameters, i,e, logic, 
limited/wrap-around integer, signed/unsigned discrete, continuous, enumeration. 
As for variables and parameters, the message type is not visible in the diagram. In 
the "Tree Pane", no special icon indicates the message type, it is visible only textu-
ally in the "Outline" tab.

All messages can be of scope exported or imported, only send & receive messages 
can be of scope local (cf. section 6.1 on page 38). However, the scope is not shown 
in the block diagram or in the "Tree Pane", it is visible only in the Properties editor.

component 
type

icon remarks

modulea)

a) The small blue boxes with letters denote the item type, i.e. Block diagram, C code, or
ESDL.

Modules can only be 
included in other mod-
ules.

classa) 

state 
machine

State machines, Boolean 
tables and conditional 
tables are special 
classes.

Boolean 
table
conditional 
table
record
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Scalar messages:

name palette / toolbar 
icon

block diagram icon "Tree Pane" icona)

a) The letter icons ( / / ) are shown only in the "Outline" tab.

Receive 
Message

Send 
Message

Send & 
Receive 
Message
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Non-scalar messages: Non-scalar messages cannot be created via the "Ele-
ments" toolbar or palette. See the online help for further information.

5.4.2 Resources 
A resource represents a part of an application that can only be used exclusively. In 
order to access a resource, there are two methods: 

- void reserve(): the resource is reserved, i.e. access to it is blocked. 

- void release(): the resource is released, i.e. access to it is granted 
again. 

name block diagram icon "Tree Pane" icona)

a) The letter icons ( / / ) are shown only in the "Outline" tab.

Receive 
Message
of array / matrix / 
record type

 

Send 
Messageb)

of array / matrix / 
record type

b) Each input pin of the record message has a sequence call. These are hidden in the
images for clarity.

Send & Receive 
Messagea

of array / matrix / 
record type

name palette / toolbar 
icon

block diagram icon "Tree Pane" icon

Resource
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5.4.3 dT Parameter
In control engineering applications the result of the calculations within a compo-
nent often depends on the value of the sampling rate. ASCET provides the system 
parameter dT for uniformly describing the algorithms for all sampling rates. The 
value of this parameter is provided by the operating system and represents the 
time difference since the last activation of the currently active task.

In a block diagram component, dT is of scope imported. In a project, dT is of scope 
exported.

5.5 Signature Elements
ASCET block diagrams can contain elements of method and process signatures.

- Method signature elements (section 5.5.1 on page 32)

- process signature elements (section 5.5.2 on page 35)

5.5.1 Method Signature Elements
The signature elements of a method can only be created in the signature editor. A 
method can have the following signature elements:

- arguments (“Method Arguments” on page 33)

- local variables (“Local Variables (Method)” on page 33)

- return value (“Return Value” on page 34)

name palette / toolbar 
icon

block diagram 
icon

"Tree Pane" icon

dT   (in block 
diagram)

 (in project)
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5.5.1.1 Method Arguments 

5.5.1.2 Local Variables (Method)

Argument type block diagram icon Icon in "Tree Pane" and 
signature editor

scalar
(logic, limited/wrap-
around integer, 
signed/unsigned 
discrete, continu-
ous)

 

enumeration

composite

complex  

variable type block diagram icon icon in "Tree Pane" and 
signature editor

scalar
(logic, limited/wrap-
around integer, 
signed/unsigned 
discrete, continu-
ous)

 

enumeration

composite
(explicit reference)
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5.5.1.3 Return Value

composite
(instance)

record
(explicit reference / 
instance)

complex
(except record; 
always explicit refer-
ence)

return value type block diagram icon icon in "Tree Pane" and 
signature editor

scalar
(logic, limited/wrap-
around integer, signed/
unsigned discrete, con-
tinuous)

 

enumeration

composite

complex

variable type block diagram icon icon in "Tree Pane" and 
signature editor
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5.5.2 Process Signature Elements
The signature elements of a process can only be created in the signature editor. A 
process can have the following signature elements:

- local variables 

5.6 Miscellaneous Elements
Several other elements are available in ASCET block diagrams:

- implementation casts (section 5.6.1 on page 36)

- hierarchies (section 5.6.2 on page 36)

- self (section 5.6.3 on page 37)

- comments (section 5.6.4 on page 37)

variable type block diagram icon icon in "Tree Pane" and 
signature editor

scalar
(logic, limited/
wrap-around inte-
ger, signed/
unsigned discrete, 
continuous)

 

enumeration

composite
(explicit 
reference)

composite
(instance)

record
(instance /explicit 
reference)

complex
(except record; 
always explicit ref-
erence)
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5.6.1 Implementation Casts
Implementation casts provide the user with the ability to influence the implemen-
tation of intermediate results within arithmetic chains. This allows the user to dis-
play knowledge regarding particular physical correlations (for example, that a 
specific range of values is not exceeded at a defined point in the model) in the 
model, without requiring the allocation of physical memory.

Implementation casts cannot be used in conjunction with logical elements.

5.6.2 Hierarchies and Statement Blocks
In order to structure a block diagram, graphical hierarchies can be used. Graphical 
hierarchies do not influence the semantics of a block diagram, but are used for 
structuring only.

Statement blocks can be used to encapsulate a continuous set of block diagram 
statements. 

A hierarchy or a statement block contains a part of the block diagram. At its parent 
level of the diagram, it is visible only as a symbol. The lines that cross the border of 
the hierarchy or statement block, i.e. that connect elements inside the hierarchy/
statement block with those outside, are represented by pins.

name palette / toolbar 
icon

block diagram 
icon

"Tree Pane" icon

Implementation 
Cast

 

name palette / 
toolbar icon

block diagram icon "Navigation" tab 
icona)

a) Hierarchies, statement blocks, their inpins and outpins are not shown in the "Out-
line" tab.

Hierarchy  

Statement 
block

 

Inpin (none)  

Outpin (none)  
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5.6.3 Self
The Self element is a reference to the currently edited component itself. 

5.6.4 Comments
ASCET block diagrams can include textual comments.

name palette / 
toolbar icon

block diagram icon
(= layout of currently edited compo-
nent)

"Navigation" 
tab icona),b) 

a) The Self element is not shown in the "Outline" tab.
b) The icon depends on the component type (see also section 5.3)

Self  

name toolbar button block diagram icon
(= comment text)

"Navigation" tab 
icona)

a) Comments are not shown in the "Outline" tab.

Comment  
ETAS ASCET V6.4 | Icon Reference Guide



38 | Miscellaneous Icons
6 Miscellaneous Icons
This chapter lists various icons used for different purposes in block diagrams.

- section 6.1 "Scope Icons" on page 38

- section 6.2 "Icons for Properties" on page 39

- section 6.3 "Icons in the "Tree Pane"" on page 40

- section 6.4 "Icons in the "General" Toolbar" on page 41

- section 6.5 "Icons in Tab Labels" on page 42

6.1 Scope Icons
The following scopes are available for ASCET elements:

- imported, exported, local, method-/process-local

Each scope is represented by a pattern on the basic variable or parameter icon.

The scope icons appear in various places, e.g., the "Tree Pane" or the block dia-
gram.

scope definition icon
exported Exported elements are defined in one component 

and can be accessed by all other components by 
importing that element.

imported Imported elements are defined in another 
component or project, but can be used in the 
component that imports them. 

local Local elements can only be used within the compo-
nent that defines them, i.e. in all methods or pro-
cesses of that component.

method-/
process-locala)

a) variables only

Method-/process-local elements can only be used in 
the method/process that define them.
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6.2 Icons for Properties
Several element properties are marked by overlay icons to the basic variable or 
parameter icon.

property definition block diagram 
icon

"Tree Pane" 
icon

referencea)

a) only available for variables

Marks a reference type (i.e. 
composite or complex element) 
as explicit reference.

virtualb)

b) Virtual messages can be created, but they are not marked with an overlay icon.

Virtual variables/parameters are 
only available in the specifica-
tion platform, they bear no rele-
vance for code generation.

dependentc)

c) only available for parameters

Model parameters can be con-
nected to other system or 
model parameters via a mathe-
matical dependency.

non-volatiled),e)

d) overlay icon only shown for non-volatile variables
e) Non-volatile messages can be created, but they are not marked with an overlay

icon.

In the ECU, the element is 
placed in the non-volatile mem-
ory.
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6.3 Icons in the "Tree Pane"
Most icons that appear in the tabs of the "Tree Pane" have already been men-
tioned. The remaining ones are listed here.

Each tab in the "Tree Pane" contains some buttons.

You can customize the content of the "Outline" and "Navigation" tabs in the ASCET 
options window, "Appearance\Tree Pane\Filter\Navigation Tree" and "Appear-
ance\Tree Pane\Filter\Outline Tree" nodes.

location icon explanation

"Outline" tab public diagrama), currently not loaded (left) / 
loaded (right, blue rim)

a) also used in the "Navigation" tab

private diagrama, currently not loaded (left) / 
loaded (right, blue rim)
additional marker for the currently loaded diagram

methoda, publicb) (left) or private (right)

b) A similar icon marks the "Methods" tab in the "Browse" view (cf. section 6.5).

processa,c) (always public)

c) in modules only

indicates the process/method most recently 
used

"Navigation" tab root node for the "Graphic Blocks" tree structure

root node for the "Sequence Calls" tree structure

connection lined) between two diagram items

d) By default, no connections are shown in the "Navigation" tab.

button icon remarks

Change filter 
settings

"Outline" and "Navigation" tab only; can be used to 
filter the tabs.
An active filter is indicated by a green overlay icon.

Change sort 
criteria

"Outline" tab only; can be used to sort the tab.

Expand All

Collapse All

Search the Tree
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6.4 Icons in the "General" Toolbar
Besides default buttons such as Save or Print, the "General" toolbar contains the 
following buttons:

button name icon explanation remarks

Switch to 
Connection Mode

starts the element con-
nection mode

Redraw reloads the current dia-
gram

Save, Print, Cut, 
Copy, Paste, 
Delete, Undo, 
Redo

default functionality

Edit Component 
Data

opens the data editor 
for the edited compo-
nent

A similar icon (without 
pencil) marks the "Data" 
tab in the "Browse" view.

Edit Component 
Implementation

opens the implementa-
tion editor for the 
edited component

A similar icon (without 
pencil) marks the 
"Implementation" tab in 
the "Browse" view.

Edit Default 
Project

opens the default proj-
ect for the edited com-
ponent

Tool Options opens the ASCET 
options window

Insert Component inserts a component as 
complex element

Insert Method creates a new method 
in the current diagram

A similar icon (without +) 
marks the "Methods" 
tab in the "Browse" view.

Insert Process creates a new method 
in the current diagram

Browse to Parent 
Component

opens an editor for the 
including component

Only available if the 
edited component was 
opened from the includ-
ing component.

Generate Code generates code for the 
edited component

Compile gener-
ated Code

compiles generated 
code for the edited 
component

Open Experiment generates and com-
piles code for the 
edited component and 
starts the offline exper-
iment
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6.5 Icons in Tab Labels
The following table lists the icons used in the labels of the various tabs of the block 
diagram editor.

Set Zoom to Page sets the zoom factor so 
that the entire first 
page is shown 

Set Zoom to 100% sets the zoom factor to 
100%

Set Zoom to Fit sets the zoom factor so 
that the entire diagram 
is shown 

location icon remarks

"Outline" tab These tabs are shown in the 
"Tree Pane", at the left of the 
editor window.

Name and icon of the third tab 
depend on whether you are 
working with a database or a 
workspace.

"Navigation" tab

"Database" tab
or
"Workspace" tab

"Specification" taba)

a) The icon depends on the type of the edited component (see section 5.3)

These tabs are displayed verti-
cally, near the right edge of the 
editor window."Browse" tab

"Elements" tab These tabs are subtabs of the 
"Browse" tab.

"Data" tab

"Implementation" tab

"Methods" tab

"Layout" tab

button name icon explanation remarks
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7 Contact Information

Technical Support

ETAS Headquarters
ETAS GmbH

For details of your local sales office as well as your local 
technical support team and product hotlines, take a look at 
the ETAS website:

www.etas.com/en/hotlines.php

ETAS offers trainings for its products:

www.etas.com/academy

Borsigstraße 24 Phone: +49 711 3423-0
70469 Stuttgart Fax: +49 711 3423-2106
Germany Internet: www.etas.com

https://www.etas.com
https://www.etas.com/en/hotlines.php
https://www.etas.com/academy
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